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1. Sicherheitshinweise

Dieses Gerat erfillt die EU-Bestimmungen 2014/30/EU (elektromagnetische
Kompatibilitat) entsprechend der Festlegung im Nachtrag 2014/32/EU (CE-
Zeichen).

Vor Inbetriebnahme der Geréte sollte die Bedienungsanleitung sorgfaltig gelesen
werden. Nachfolgend aufgefiihrte Sicherheitshinweise zum Betrieb der Gerate
unbedingt beachten. Schéaden, die durch Nichtbeachtung dieser Hinweise
entstehen, sind von Anspriichen jeglicher Art ausgeschlossen:

*  Warnhinweise am Gerat unbedingt beachten.

* Gerat keinen extremen Temperaturen, direkter Sonneneinstrahlung, extremer
Luftfeuchtigkeit oder N&sse aussetzen.

*  Starke Erschitterungen vermeiden

*  Gerat nicht in der Nahe starker magnetischer Felder (Motoren,
Transformatoren usw.) betreiben

* Heil3e Lotpistolen aus der unmittelbaren Néhe des Gerétes fernhalten

*  Vor Aufnahme des Messbetriebes sollte das Gerat auf die
Umgebungstemperatur stabilisiert sein.

* Ersetzen Sie die Batterie, sobald das Batteriesymbol "} leuchtet.
Mangelnde Batteriespannung kann unprazise Messergebnisse hervorrufen.

*  Sollten Sie das Gerét flr einen langeren Zeitraum nicht benutzen, entnehmen
Sie die Batterie aus dem Batteriefach.

* Séubern Sie das Gehé&use regelmaflig mit einem feuchten Stofftuch und
einem milden Reinigungsmittel. Benutzen Sie keine &tzenden Scheuermittel.

*  Vermeiden Sie jegliche Nahe zu explosiven und entflammbaren Stoffen.

* keine technischen Veranderungen am Geréat vornehmen

*  Offnen des Gerétes fir Wartungs- und Reparaturarbeiten dirfen nur von
qualifizierten Service-Technikern durchgefihrt werden.

* Messgeréte gehoren nicht in Kinderhénde !

Reinigung des Gerates

Gerat nur mit einem feuchten, fusselfreien Tuch reinigen. Nur handelstbliche
Spulmittel verwenden. Beim Reinigen unbedingt darauf achten, dass keine
Flussigkeit in das Innere des Gerates gelangt. Dies kdnnte zu einem Kurzschluss
und zur Zerstérung des Gerates fuhren.



2. Einfihrung

Diese Serie von Datenloggern fir Lufttemperatur, Luftfeuchtigkeit (P 5185);
Gleichspannung von 0 bis 30V (P 5186) und Temperaturmessungen uber Typ-K
Fuhler (P 5187) uberzeugt durch seine lange Aufnahmedauer genauen
Aufnahmedatum und Zeitpunkt, wobei 32000 Messwerte im internen Speicher
abgelegt und anschlieBend tber USB abgerufen werden kdnnen.

3. Technische Merkmale

Datenlogger mit internem Speicher bis zu 32.000 Messwerten
Mehrzeilige LCD Anzeige mit Warn-LEDs

Messrate von 10 Sekunden bis zu 12 Stunden
Auswechselbare 1/2 AA 3,6 V Lithium-Batterie

Aufnahmezeit von bis zu 2 Jahren moglich
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4. Bedienelemente und Anschliisse am Geréat

P 5185:

5
Leer
Funktionstaste zum Starten und Stoppen des Aufzeichnungsvorgangs
LCD-Anzeige
Status LED

LED-Anzeige bei niedriger Batteriespannung

USB-Steckanschluss

~No(a|A|wW(N|-

Externer Sensor zur Messung der Temperatur und Luftfeuchtigkeit
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P 5186:

Schraubklemmen fiir Spannungsmessung

Funktionstaste zum Starten und Stoppen des Aufzeichnungsvorgangs

LCD-Anzeige

Status LED

LED-Anzeige bei niedriger Batteriespannung

o lw|N|F

USB-Steckanschluss




P 5187:

Eingang fir Typ-K Temperaturfihler

Funktionstaste zum Starten und Stoppen des Aufzeichnungsvorgangs

LCD-Anzeige

Status LED

LED-Anzeige bei niedriger Batteriespannung

o lw|N|F

USB-Steckanschluss




4.1. Symbole in der Anzeige
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—goon
i

—F3 QO
0—

*—F] Log

1. Zeigt die Mal3einheit des angezeigten Messwertes an.

2. Messwert wird angezeigt.

3. ,,?“—Symbolanzeige bedeutet, dass ein Teil der aufgezeichneten Messungen
Uberschreiten den oberen Grenzwert.

4. ,,i“—SymboIanzeige bedeutet, dass ein Teil der aufgezeichneten Messungen
Uberschreiten den unteren Grenzwert.

5. Die Anzeige wechselt je nach Ladezustand von {ITH zu E Eine leere
Batterie sollte umgehend erneuert werden.

6. LOG-Symbol wird angezeigt, sobald der Logging-Modus aktiv ist und
Messwerte aufgezeichnet werden.

7. Eswird der Kanal angegeben, dessen aktuelle Messwerte angezeigt werden.

HINWEIS:

Das LCD funktioniert nicht bei unter -10°C.
Fir weitere Informationen zu der Software koénnen Sie das Hilfe-Menu innerhalb der
Software nutzen.
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5. Installation

5.1. Batterie einlegen

Um den Datenlogger in Betrieb zu nehmen, muss zuerst die 3,6V Lithium Batterie
eingelegt werden.

waeis:
Achten Sie darauf, diesen Anschluss

mit dem Gehauseteil auszurichten,
wenn Sie das Geréat wieder aufsetzen.




5.2. Software Installation

Um den Datenlogger in Betrieb zu nehmen, muss zuerst die PC-Software von der
beiliegenden CD installiert werden.

Legen Sie hierzu die beiliegende Software-CD in das CD/DVD-Laufwerk lhres PC’s
ein.

Wenn das Programm nicht automatisch ausgefiihrt wird, fiihren Sie einen
Doppelklick der Datei ,Setup.exe” aus und installieren Sie das Programm in einen
beliebigen Ordner auf Ihrer Festplatte.

Folgen Sie den Bildschirmanweisungen, um die Installation abzuschlieRen.
Es wird ein neues Symbol ,Datenlogger Graph* auf dem Desktop angezeigt.

Bitte beachten Sie, dass Sie den USB-Treiber nach Abschluss der Software-

Installation installieren missen, um die Datenlogger-Software verwenden zu
kénnen.

5.3. Installation des USB-Treibers

Nach Abschluss der Software-Installation, stellen Sie sicher, dass die Software-CD
in lhren CD/DVD-ROM-Laufwerk Ihres PC’s eingelegt ist.

Doppelklick auf die Datei "USBXpressinstaller.exe" im Verzeichnis ,Treiber” auf der
CD, um mit der Installation zu beginnen.

Folgen Sie den Bildschirmanweisungen, um die Installation des USB-Treibers
abzuschlieen.

Sie konnen nun den Datenlogger in einen freien USB-Anschluss lhres PC’s
einstecken.

Einen Moment spéter wird Ihr Computer die Meldung ausgeben, dass die Treiber
fur den Datenlogger vollsténdig installiert wurden und das Geréat nun verwendet
werden kann.

Nun, haben Sie erfolgreich die erforderliche Software und USB-Treiber fiir lhren
Datenlogger installiert.

Hinweis:
Das Gerét kann nur in Verbindung mit der Software genutzt werden und wird nicht
als externer Datentrager erkannt.



6. Bedienung

6.1. Einstellungen vor der Anwendung

Um den Datenlogger zu verwenden, gehen Sie folgendermaRen vor:

1.
2.

3.

Stellen Sie sicher, dass der Akku richtig eingesetzt wurde.

Stecken Sie den Datenlogger in einen freien USB-Port lhres PC's, auf dem
die Data Logger Graph Software und die zugehdrigen Treiber installiert sind.
Doppelklicken Sie auf das Symbol "Datenlogger Graph" auf lhrem Windows-
Desktop. Dadurch wird die Datenlogger Graph Software gestartet. An der
linken oberen Seite des Software-Fensters befindet sich die Schaltflache
"Start". Klicken Sie darauf, um das Dialogfeld "Data Logger Device" zu 6ffnen.
Wahlen Sie den aktuellen Datenlogger aus. Hier kdnnen Sie die Firmware-
Version, Status, etc. des ausgewahlten Datenloggers tiberprifen.

Klicken Sie auf die Schaltfliche "Setup" um das Dialogfeld "Data Logger
Setup" zu offnen. Folgen Sie den Bildschirmanweisungen, um lhren
Datenlogger einzurichten und Einstellungen vorzunehmen. In der
Registerkarte "General" konnen Sie Ihren Datenlogger benennen und die
Messrate einstellen. In der Registerkarte "Channel Settings" konnen Sie die
oberen/unteren Grenzwerte festlegen und Alarmeinstellungen vornehmen. In
der Registerkarte "Start und Stop-Method“ kénnen Sie die festlegen, wie der
Datenlogger die Aufzeichnung beginnen bzw. beenden soll. Der Datenlogger
ist beim ersten Start der Software auf Standardwerte voreingestellt.

Klicken Sie auf die Schaltflache "Finish". Der Datenlogger wird gemaf lhren
Einstellungen starten.

Entfernen Sie den Datenlogger vom USB-Anschlusses lhres PC.

B Temphtiiaty - Oote Logges Graph

EmH +* 4

P ra——

Temp. and Humi. Logger
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6.2. Auswerten des Datenloggers

SchlieBen Sie den Datenlogger an lhren PC an und starten Sie die "Datenlogger
Graph" Software.

1.

Stecken Sie den Datenlogger in einen freien USB-Port Ihres PC's, auf
dem die Data Logger Graph Software und die zugehdrigen Treiber
installiert sind.

Doppelklicken Sie auf das Symbol "Datenlogger Graph" auf Ihrem
Windows-Desktop. Dadurch wird die Datenlogger Graph Software
gestartet. An der linken oberen Seite des Software-Fensters befindet
sich die Schaltflache "Start". Klicken Sie darauf, um das Dialogfeld
"Data Logger Device" zu 6ffnen.

Wahlen Sie den aktuellen Datenlogger aus. Hier kdnnen Sie die
Firmware-Version, Status, etc. des ausgewdhlten Datenloggers
Uberprifen.

Klicken Sie auf die Schaltflache "Download" auf dem Dialog "DATA
LOGGER DEVICE". Hier kdnnen Sie die Bildschirmanweisungen zum
Herunterladen und Speichern der Daten auf Ihren PC folgen.

Ist der Download abgeschlossen, wird die Meldung "Download
finished* (Download beendet) angezeigt und Sie kénnen mit der
Schaltflache "Offnen” die heruntergeladenen Daten grafisch darstellen
lassen.
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6.3. Auswerten der Messdaten mit einem Kurvendiagramm

1. Doppelklicken Sie auf das Symbol "Datenlogger Graph" auf Ihrem Windows-
Desktop, um die Datenlogger Graph Software zu starten.

2. Uber das Menii "Datei > Offnen” kénnen Sie eine Datenlogger-Datei (* .dlg, *
.mdlg) 6ffnen und das Kurvendiagramm anzeigen lassen.

3. VergréRern (Zoom In):

a. Klicken Sie mit der Maus innerhalb des Diagrammbereiches und
ziehen Sie einen Rahmen, um den gewtinschten Bereich zu
vergroRRern.

b. Verkleinern (Zoom Out):
Klicken Sie auf "Undo Last" oder "Undo All" in der Werkzeugleiste, um
das letzte Kurvendiagramm oder das urspriingliche Diagramm
anzeigen zu lassen.

4. Pan: Halten Sie die mittlere Maustaste gedrickt. Nun kénnen Sie das
Kurvendiagramm frei bewegen/positionieren und im Diagrammbereich
verschieben.

5. Zoom und Pan-Methode:
Auto: Zoom und Pan in eine beliebige Richtung.
Horizontal: Zoomen und schwenken nur in horizontaler Richtung.
Vertikal: Zoomen und schwenken nur in vertikaler Richtung.

6. Markieren von Datenpunkten:
Klicken Sie mit der rechten Maustaste auf einen Punkt das Kurvendiagramms.
Ein Pop-Up-Menti wird angezeigt. Klicken Sie nun auf “Label Data Point", um
den ausgewahlt Punkt zu markieren.

7. Graph Settings: Klicken Sie mit der rechten Maustaste auf den Diagramm-
Bereich und ein Popup-Meni wird angezeigt. Klicken Sie auf "Graph-Settings",
um das Dialogfeld ,Graph Settings* aufzurufen. Hier kénnen Farbe, Schriftart,
GrofRe und Zeileneinheit fur das Diagramm festgelegt werden.

7. Datei exportieren

Die Software speichert und o6ffnet Dateien des Typs *.dlg oder *.mdig
standardmagig.

Mit ,Save as..." im Menu ,File" kdnnen Sie zwischen verschiedenen Dateitypen
auswahlen: *.dIg; *.mdlg; *.txt; *.csv; *.xIs; *.omp und *.jpg
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8. Drucken

Um den Graphen, Statistiken und Datentabelle drucken, klicken Sie auf das
Druckersymbol auf Standard-Werkzeugleiste oder wahlen Sie "Drucken” aus dem
"File" im Pulldown-Mend.

Benutzer kénnen auch auf das "Datei-> Drucken und Exportoptionen” wahlen Sie
die gedruckten Inhalte der folgende Dialog.

-
Print and Export Options M

Please select the fllowing items that will be printed or
exproted in pdf file type:

Graph Statistics Data Table

ok | cancel
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keine LED blinkt
Datenlogger befindet sich im Ruhezustand, die Batterie ist erschopft
oder _es ist keine Batterie eingebaut.

LED blinkt grin alle 10 s
Der Datenlogger befindet sich aktuell im Aufzeichnungsmodus.

Beide LEDs blinken griin alle 10s

Der Datenlogger wird ab dem vom Benutzer voreingestellten Datum -
und Zeit mit der Protokollierung beginnen oder es soll daran erinnert
werden, dass der Benutzer die Taste zum Starten driickt.

Beide LEDs blinken griin alle 60s
Der Datenlogger hat die vom Benutzer voreingestellte Protokollierung
beendet und die Aufzeichnung angehalten.

LED blinkt rot alle 10s

. Der Datenlogger befindet sich aktuell im Aufzeichnungsmodus.
Der Alarm-Modus (High / low / oder beide) auf einem Kanal ist
aktiviert.*

Beide LEDs blinken rot alle 60s

Der Datenlogger hat die vom Benutzer voreingestellte Protokollierung
beendet und angehalten.

. . Alarm (hoch, niedrig oder beides) auf mindestens einem Kanal ist
aktiviert.

Hinweis:

Dieser Zustand tritt nur auf, wenn Alarm-Hold aktiviert ist.

LED blinkt gelb alle 60s

Anzeige fiir niedrige Batteriespannung. Die Protokollierung wird
fortsetzt, jedoch sollte die Batterie baldmdglichst Gberpriift und ersetzt
werden.

LED blinkt gelb alle 1s

Zeigt an, dass einen USB-Verbindung besteht.

Abwechselnd blinkt eine LED gelb und die Andere griin
Batterie ist installiert und das Gerét kann verwendet werden.

‘ Abwechselnd blinkt eine LED gelbe und die Andere rot
Batterie ist installiert, jedoch kann das Gerét nicht gestartet werden.

Batteriestatus kann tber den Data Logger Geréatedialog in der Datenlogger
Graph-Software Uberpriift werden. Selbst wenn der Akku leer ist, gehen die
aufgezeichneten Daten nicht verloren.

Start und Stop-Methode kann Uber den Data Logger Setup-Dialogfeld in der
Datenlogger Graph Software eingestellt werden.

Rote Alarm-LED fir jeden Kanal und griine LED-Statusanzeige kann tber den
Data Logger Setup-Dialogfeld in der Datenlogger Graph Software fir Strom
sparen deaktiviert werden.

Wenn Alarm-Hold aktiviert ist, wird die rote LED blinken, sobald die Messwerte
die eingestellte Alarmgrenze Uberschritten haben und
auch wenn die Messwerte in den normalen Bereich wieder zurtickkehren. Dies
sorgt dafur, dass Sie immer wissen, wenn die Alarmgrenze uberschritten
wurde.
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9. Funktionstaste

Der Datalogger verfligt nur Uber eine Funktionstaste. Die jeweilige Funktion ist
abhangig davon, in welchem Modus sich der Datalogger zu dem Zeitpunkt befindet:
Wenn Sie Uber das Data Logger Setup-Dialogfeld in der Datenlogger Graph-
Software den Start der Protokollierung durch Tastendruck wéahlen, kénnen Sie
durch driicken und gedrtickt halten der Funktionstaste (bis die griine LED leuchtet)
die Protokollierung starten.

Wenn Sie Uber das Data Logger Setup-Dialogfeld in der Datenlogger Graph-
Software auswahlen, dass Sie vorhandene Daten lberschreiben méchten, wenn
der Datenlogger die Protokollierung aufgrund von erschoépften Speicher gestoppt
hat, kdnnen Sie durch driicken und gedrtickt halten der Funktionstaste (bis die
griine LED leuchtet) die Protokollierung stoppen.

Wenn Sie Uber das Data Logger Setup-Dialogfeld in der Datenlogger Graph-
Software den LED Alarm (obere und untere Grenzwerte festgelegt) eingestellt und
aktiviert haben und somit bei Uber — bzw. Unterschreitung die rote LED bei Alarm
blinkt, kdnnen Sie durch driicken und gedriickt halten der Funktionstaste (bis die
rote LED leuchtet), den LED Alarm zurlickzusetzen.

So erhalten Sie korrekte Messergebnisse
Vor Beginn einer Aufzeichnung sollten Sie die Batteriekapazitét tberprifen.
Beachten Sie beim Einsatz des Datenloggers die spezifizierten

Umgebungstemperaturen und Luftfeuchtigkeitswerte, um korrekte Messergebnisse
zu erhalten.
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10. Technische Daten

Allgemein:
Speicher 64k Bytes (32.000 Messwerte)
einstellbar von 10 Sekunden bis 12
Messrate

Stunden

Messung starten

Sofort; Start durch Tastendruck; Start nach
Zeit/Datum-Voreinstellung

Messung stoppen

Messung stoppt, wenn Speicher erschopft
Messung stoppt, wenn voreingestellter
Messpunkt erreicht wurde

LED-Anzeige

Rote & griine LED

Statusanzeige des Datenloggers:
Umfasst die Verzogerung des Startes der
Messung, Anzeige bei Aufzeichnung von
Messwerten (Logging), Alarm und
Messung beendet

Mit Hilfe der Software kénnen diese
beiden LED’s deaktiviert werden, um die
Batteriespannung zu sparen.

Gelbe LED
Anzeige bei niedriger Batteriespannung

Lénge Sensor

Lénge der Messleitung: 3 Meter

Schutzart IP 20

Batterie Y% AA 3.6V Lithium-Batterie 1200mAh

Batterie- B!s zu 2 Jahren abhéangig von der

einsatzdauer E|nstg|lung der Messrate und der LED-
Anzeige

Betriebstemperatur 20°C, +5°C

Abmessungen (BxHXT) 38 x 122 x 22 mm

Gewicht 60g
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PeakTech® 5185

2 Kanal-Datalogger:
Kanéle Kanal 1: Luftfeuchte RH%
Kanal 2: Temperatur

Relative Luftfeuchtigkeit (RH%)

[ Messbereich [ Auflosung | Genauigkeit
[ 0...100% | 0,1%RH | +3,0% RH
Lufttemperatur
Messbereich Auflésung Genauigkeit
-40...125°C 0,1°C +0,3°C
(-40 ...257°F) 0,1°F +0,5°F
PeakTech® 5186
Gleichspannung (DCV)
[ Messbereich [ Auflésung | Genauigkeit
[0..30vDC [ 0,00v | +/-1,0% v.M. + 6 Stellen

PeakTech® 5187

Temperatur-Eingange Typ-K

Messbereich Auflésung Genauigkeit
-200 ... 1300°C 0,1°C +0.5°C
-328 ... 2372°F 0,2°F +0.9°F
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11. Auswechseln der Batterie

Bei Aufleuchten des [[_}-Symbols muss die Batterie gewechselt werden.
Offnen Sie das Gerét wie in Abschnitt 5.1 beschrieben und entfernen Sie die
verbrauchte Batterie und setzen eine neue gleichen Typs ein (3,6V Li-Batterie).
Verbrauchte Batterien sind Sondermll und missen in die dafir vorgesehenen
Sammelbehélter gegeben werden.

Nehmen Sie das Gerét nie in Betrieb, wenn es nicht vollig geschlossen ist.

Hinweis:

1. Halten Sie das Gerat trocken.

2. Halten Sie die Sonden sauber.

3. Bewahren Sie das Gerat auRRerhalb der Reichweite von Kindern auf.
4.

Wenn das Symbol " " erscheint, ist die Batterie leer und sollte
schnellstmdglich ersetzt werden. Wenn Sie eine Batterie einsetzen, achten Sie
auf korrekte Polaritat der Batterie. Wenn Sie das Gerat fir einen langeren
Zeitraum nicht bendtigen, entfernen Sie die Batterie aus dem Gerat.

11.1. Hinweise zum Batteriegesetz

Im Lieferumfang vieler Gerate befinden sich Batterien, die z. B. zum Betrieb von
Fernbedienungen dienen. Auch in den Geraten selbst kdnnen Batterien oder Akkus
fest eingebaut sein. Im Zusammenhang mit dem Vertrieb dieser Batterien oder
Akkus sind wir als Importeur gemaR Batterieverordnung verpflichtet, unsere
Kunden auf folgendes hinzuweisen:

Bitte entsorgen Sie Altbatterien, wie vom Gesetzgeber
vorgeschrieben- die Entsorgung im Hausmdill st laut
Batterieverordnung ausdriicklich verboten-, an einer kommunalen
Sammelstelle oder geben Sie sie im Handel vor Ort kostenlos ab.
Von uns erhaltene Batterien kdnnen Sie nach Gebrauch bei uns
unter der auf der letzten Seite angegeben Adresse unentgeltlich
zuriickgeben oder ausreichend frankiert per Post an uns
zurticksenden.

Schadstoffhaltige Batterien sind mit einem Zeichen, bestehend aus einer
durchgestrichenen Mulltonne und dem chemischen Symbol (Cd, Hg oder Pb)
des fur die Einstufung als schadstoffhaltig ausschlaggebenden
Schwermetalls versehen: ,CD* fir Cadmium, ,Pb“ steht fir Blei und ,Hg* fir
Quecksilber.
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Alle Rechte, auch die der Ubersetzung, des Nachdruckes und der Vervielfaltigung
oder Teilen daraus, vorbehalten. Reproduktionen jeder Art (Fotokopie, Mikrofilm
oder ein anderes Verfahren) nur mit schriftlicher Genehmigung des Herausgebers
gestattet.

Letzter Stand bei Drucklegung. Technische Anderungen des Gerétes, welche dem
Fortschritt dienen, vorbehalten.

Hiermit bestétigen wir, dass alle Gerate die in unseren Unterlagen genannten
Spezifikationen erfillen und werkseitig kalibriert geliefert werden.

Eine Wiederholung der Kalibrierung nach Ablauf von einem Jahr wird empfohlen.

© PeakTech® 06/2020 Mi/HR/TW
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1. Safety precautions

This product complies with the requirements of the following European
Community Directives: 2014/30/EU (Electromagnetic Compatibility)) as
amended by 2014/32/EU (CE-Marking).

The following safety precautions must be observed before operation.
Damages resulting from failure to observe these safety precautions are
exempt from any legal claims whatever:

*

*

Comply with the warning labels and other info on the equipment.

Do not subject the equipment to direct sunlight or extreme temperatures,
humidity or dampness.

Do not subject the equipment to shocks or strong vibrations.

Do not operate the equipment near strong magnetic fields (motors,
transformers etc.).

Keep hot soldering irons or guns away from the equipment.

Allow the equipment to stabilize at room temperature before taking up
measurement (important for exact measurements).

Replace the battery as soon as the battery indicator “@_}” appears. With
a low battery, the meter might produce false reading.

Fetch out the battery when the meter will not be used for long period.
Periodically wipe the cabinet with a damp cloth and mid detergent. Do
not use abrasives or solvents.

Do not store the meter in a place of explosive, inflammable substances.
Do not modify the meter in any way.

Opening the equipment and service- and repair work must only be
performed by qualified service personnel.

Measuring instruments don’t belong to children hands.

Cleaning the cabinet

Clean only with a damp, soft cloth and a commercially available mild
householder cleanser. Ensure that no water gets inside the equipment to
prevent possible shorts and damage to the equipment.
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2. Introduction

This series of data loggers for temperature, humidity (P 5185); DC voltage from O to
30V (P 5186) and temperature measurements via type K probe (P 5187) convinces
by its long recording time exact recording date and time, with 32 000 readings in
internal memory and then can be accessed via USB.

3. Technical features

» Data logger with internal memory up to 32.000 readings
» Multi-line LCD display with warning LEDs

» measuring rate from 10 seconds up to 12 hours

» Replaceable 1/2 AA 3.6V lithium battery

» recording time up to 2 years possible
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4. Panel description
P 5185:

Empty

Function switch to start and stop of the logging process

LCD-Display

Status LED

LED-Display if battery is low

USB-Port

~No(a|A|wW(N|-

External sensor for measuring Temperature & Humidity (RH%)
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P 5186:

1 Terminals for voltage measurement

2 Function switch to start and stop of the logging process
3 LCD-Display

4 Status LED

5 LED-Display if battery is low

6 USB-Port
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P 5187:

Input for type-K temperature sensor

Function switch to start and stop of the logging process

LCD-Display

Status LED

LED-Display if battery is low

o lw|N|F

USB-Port
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4.1. Symbols in the display

\— PPMRH%°C°F
_gonn

o
g
*—[l Loa

1. Indicates the unit of the displayed value.

2. Shows the actual measurement value.

3. ,,?“—symbol means that a part of the recorded measurements exceed the upper
limit.

4. ,,i“—symbol means that a part of the recorded measurements exceed the lower
limit value.

5. The display changes depending on state of charge from FE to E . An
empty battery should be replaced immediately.

6. LOG icon is displayed when the logging mode is active and readings are
recorded.

7. ltis stated the channel whose current readings are displayed.

NOTE:

The LCD does not work below -10 °C.
For more information about the software you can use the Help menu within the
software.
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5. Installation

5.1. Insert the battery

To take the data logger into operation, the 3.6V lithium battery must be inserted at
first.

3
o

Note:
Be sure to align this connection
to the housing part, if you do it on again.
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5.2. Software Installation

To take the data logger into operation, the PC software must be installed from the
CD first.

Please insert the software CD into the CD / DVD drive of your PC. If the program
does not run automatically, double click the "setup.exe" file and install it in any
folder on your hard drive.

Follow the onscreen instructions to complete the installation.
It appears a new symbol "Datalogger Graph" on the desktop.

Please note that you must install the USB drivers after installing the software in
order to use the Data Logger software.

5.3. Installing the USB driver

After completing the software installation, make sure that the software CD is
inserted into your CD / DVD-ROM drive of your PC.

Double-click on the file "USBXpressinstaller.exe" in the folder "Driver" on the CD to
begin the installation.

Follow the onscreen instructions to complete the installation of the USB driver.
You can now plug the data logger into a free USB port of your PC.

A moment later, your computer will display a message that the driver for the data
loggers were fully installed and the device can be used now.

Now, you have successfully installed the required software and USB drivers for
your data logger.

Note:

The device can be used only in conjunction with the Software and is not recognized
as an external hard disk.
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6. Operation

6.1. Settings before use

To use the data logger, proceed as follows:

W Tempann.

1.
2.

3.

Make sure the battery is inserted correctly.

Plug the data logger into a free USB port of your PC, on which the
datalogger Graph software and drivers are installed.

Double-click on the icon "Datalogger Graph" on your Windows desktop
to start the datalogger Graph software. In the upper left side of the
software window the "Start" button is located. Click it to open the dialog
box "Device Data Logger".

Select the current datalogger. You can check the firmware version,
status, etc. of the selected data logger.

Click the tab "Setup” to display the "Data Logger Setup”. Follow the
onscreen instructions to set up your data logger and adjust settings. In
the "General" tab, you can rename your data logger and set the
measuring rate. In the "Channel Settings" tab, you can set the upper /
lower limits and alarm settings. In the "Start and Stop Method" tab you
can specify how the data logger should start or stop recording. The
data logger is preset when you first start the software to the default
values.

Click the "Finish" button. The data logger will start according to your
settings.

Remove the data logger from the USB port of your PC.

- Dote Logges Grmph
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6.2. Evaluating the data logger

Connect the data logger to your PC and start the "data logger graph" software.

1.

Insert the data logger into a free USB port of your PC, on which the
datalogger Graph software and drivers are installed.

Double-click on the icon "Datalogger Graph" on your Windows desktop
to start the datalogger Graph software. In the upper left side of the
software window the "Start" button is located.

Select the current datalogger. You can check the firmware version,
status, etc. of the selected data logger.

Click on the "Download" button in the dialog "DATALOGGER DEVICE".
You can follow the onscreen instructions to download and save the
data to your PC.

If the download is complete, the message "Download finished"

(Download complete) will be displayed and you can display the "Open"
button which downloaded data graphically.
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6.3. Evaluation of the measurement data with a graph

1. Double-click on the icon "Datalogger Graph" on your Windows desktop
to start the datalogger Graph software.

2. By using the menu "File - Open" you can open a data log file (*.dlg,
*.mdlg) and display the graph.

3. Zoom (Zoom In):
a. Click the mouse inside the graph area and drag a box to zoom in
the desired range.
b.  Zoom Out (Zoom Out):
Click "Undo Last" or "Undo All" in the toolbar to display the last
graph or the original diagram.

4. Pan: Press and hold the middle mouse button. Now you can use the
graph to move freely / position and move the graph area.

5. Zoom and Pan Method:
Auto: Zoom and Pan in any direction.
Horizontal: Zoom and pan in horizontal direction only.
Vertical: Zoom and pan in the vertical direction only.

6. Mark of data points:
Click with the right mouse button on a point of the curve diagram. A
pop-up menu will appear. Now click on "Label Data Points" to mark the
selected item.

7. Graph Settings: Click the right mouse button on the chart area and a
popup menu is displayed. Click on "Graph Settings" to open the dialog
box "Graph Settings". Here you can specify color, font, size and line
unit for the chart.

7. Export File

The software saves and opens files of type *.dlg or *.mdlg as default.

With "Save as ..." from the "File" menu, you can choose between different file types:
*.dlg; *.mdlg; *.txt; *.csv; *.xls; *.bmp and *.jpg.
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8. Print

To print the graphs, statistics and data table, click the printer icon on the standard
toolbar or select "Print" from the "File" pull-down menu.

Users can also click on the “File-> Print and Export options" to choose the printed
contents of the following dialog.

-
Print and Export Options ﬂ

Please select the fllowing items that will be printed or
exproted in pdf file type:

Graph Statistics Data Table

ok | cancel
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No LED flashes
Data logger is in idle state, the battery is exhausted or
there is no battery installed.*

LED flashes green every 10 s
The data logger is currently in the recording mode.

Both LEDs flash green every 10s

The data logger will start the logging by Date — Time, which is
predefined by the user or it should be recalled that the user presses
the button to start.

Both LEDs flash green every 60s
The data logger has completed the preset logging by the user and
stopped the recording.

LED flashes red every 10s
. The data logger is currently in the recording mode.
The Alarm Mode (High / Low / or both) on a channel is enabled.*

Both LEDs flash red every 60s
The data logger has completed the preset logging by the user and

. . stopped.

Alarm (high, low or both) on at least one channel is enabled.
Note:
This condition occurs only if the alarm Hold is enabled.

LED flashes yellow every 60s

Display for low battery voltage. The logging continues, however the
battery should be checked and replaced as soon as possible.

LED flashes yellow all 1s

Indicates that an USB connection exists.

Alternately one LED flashes yellow and the other green
Battery is installed and the device can be used.

‘ Alternately one LED flashes yellow and the other red
Battery is installed but the unit cannot start.

Battery status can be checked via the Data Logger device dialog in the
datalogger Graph software. Even if the battery is empty, the recorded data do
not lost.

Start and stop method can be set via the Data Logger Setup dialog box in the
datalogger Graph software.

Red alarm LED for each channel and green LED status indicator can be
turned off to save battery on the Data Logger Setup dialog box in the
datalogger Graph Software.

If alarm Hold is activated, the red LED will flash once the readings have
exceeded the preset alarm limit and even if the readings return to normal
range. This ensures that you always know when the alarm limit has been
exceeded.

-31-




9. Function key

The datalogger has only one function key. The function depends on the mode in
which the datalogger is located at the time:

If you select via the Data Logger Setup dialog box in the datalogger Graph software
to start logging by pressing a button, you can press and hold down the function key
(until the green LED lights up) start logging.

If you select from the Data Logger Setup dialog box in the datalogger Graph
software that you want to overwrite existing data when the data logger has stopped
logging due to depleted memory, you can press and hold down the function key
(until the green LED lights) stop logging.

If you have set on the Data Logger Setup dialog box in the datalogger Graph
software the LED alarm set (upper and lower limits) and activated and thus the red
LED flashes at increasing or decreasing of the set limits.

You can press through and pressed hold the function key (to the red LED), the LED
reset alarm.

To obtain proper measurements

Before starting a recording, you should check the battery capacity.
Note to obtain the use of the data logger the specified ambient temperatures and
humidity levels correct measurement results.
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10. Technical Data

General:
Memory 64k Bytes (32.000 Measurement Values)
Sample-Rate adjustable from 10 seconds to 12 hours

Measurement Start

Immediately; Start by pressing button;
Start by pre-set of Time/Date

Measurement Stop

Measuring stops, if memory is full
Measuring stops, when preset
measurement point has been reached

LED-Display

Red and green LED

Status display of the data logger:
Includes the delay of the start of the
measurement, display with recording of
measured values (logging), alarm and
measurement completed

Using the software, these two LEDs can
be turned off to save the battery voltage.

Yellow LED
Display low battery status

Length of the sensor

Length of the measuring line: 3 meters

Protection class

IP 20

Battery

% AA 3.6V Lithium-Battery 1200mAh

Battery Life

Up to 2 years depending on the setting of
the measuring rate and the LED display

Operating temperature

20°C, +5°C

Dimensions (WxHxD)

38 x 122 x 22 mm

Weight

60g
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PeakTech® 5185

2 Channel-Datalogger:
Channels Channel 1: Humidity RH%
Channel 2: Temperature

Relative Humidity (RH%)

[ Range [ Resolution [ Accuracy
[ 0...100% | 0,1%RH | +3,0% RH
Air -Temperature
Range Resolution Accuracy
-40...125°C 0,1°C +0,3°C
(-40 ...257°F) 0,1°F +0,5°F
PeakTech® 5186
Voltage (DCV)
[ Range [ Resolution [ Accuracy
[ 0...30vDC | 0,01v | +/-1,0% of rdg. + 6 digits

PeakTech® 5187

Temperature — Input Type-K

Range Resolution Accuracy
-200 ... 1300°C 0,1°C +0.5°C
-328 ... 2372°F 0,2°F +0.9°F
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11. Battery Replacement

If the L} -Symbol appears in the display the battery should be replaced.

Open the unit as described in section 5.1 and remove the old battery and put in a
new one of the same type (3.6V Li-battery).

Used batteries are hazardous waste and must be placed in the appropriate
collection container.

If the device is not completely closed, it should not be put into operation.

Note:

[

2.
3.
4.

Keep the device dry.

Hold the Sensors clean.

Keep the unit out of reach of children.

If the " symbol appears, the battery is exhausted and should be replaced
as soon as possible. If you are using a battery, pay attention to correct polarity
of the battery. If you do not need the device for an extended period, remove
the battery from the device.

11.1. Notification about the Battery Regulation

The delivery of many devices includes batteries, which for example serve to
operate the remote control. There also could be batteries or accumulators built into
the device itself. In connection with the sale of these batteries or accumulators, we
are obliged under the Battery Regulations to notify our customers of the following:

Please dispose of old batteries at a council collection
point or return them to a local shop at no cost. The
disposal in domestic refuse is strictly forbidden
according to the Battery Regulations. You can return
used batteries obtained from us at no charge at the
address on the last side in this manual or by posting
with sufficient stamps.

Contaminated batteries shall be marked with a symbol consisting of a
crossed-out refuse bin and the chemical symbol (Cd, Hg or Pb) of the heavy
metal which is responsible for the classification as pollutant: ,Cd“ for cadmium,
,Pb" stands for lead and ,Hg" for mercury.
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All rights, also for translation, reprinting and copy of this manual or parts are reserved.

Reproductions of all kinds (photocopy, microfilm or other) only by written permission of
the publisher.

This manual is according the latest technical knowing. Technical alterations reserved.

We herewith confirm that the unit is calibrated by the factory according to the
specifications as per the technical specifications.

We recommend to calibrate the unit again, after one year.

© PeakTech® 06/2020 Mi/HR/TW

PeakTech Prif- und Messtechnik GmbH — Gerstenstieg 4 - DE-22926 Ahrensburg /
Germany
@+49 (0) 4102 97398-80 =+49 (0) 4102 97398-99
E info@peaktech.de ®) www.peaktech.de
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